Microsoft Backup

Written by Pavel Gulyayev <aihaca@arna.kz>

Note that newer versions of Microsoft Windows may have menu items named and designed
differently from those described in this manual.

Theoretically, backup is an important part of routine computer operation. Indeed, much of the
data used is extremely valuable and practically irreplaceable. This is why there can be nothing
worse than failure of a hard disk containing such data caused by power surge, incorrect operation
of low-quality applications, virus programs, or due to mere wear-out of the medium. However, in
practice backup operation normally becomes a job that is easily postponed till “tomorrow”. It
often seems that this good old hard drive is still ok and will last as such forever. After all, who
wants to spend plenty of time copying dozens of floppy disks to create even a modest backup.

Speaking about backup, one should note that theory and practice do not correlate only till the
particular moment when a user starts his computer just to read on the display a horrifying
message “Invalid system configuration” or “Hard disk failure”. Believe me, failure of a hard disk
with unsaved (which actually means “lost”) data brings rather quick understanding of the
importance of regular backup. To avoid this bad luck, a most convenient and easy-to-do backup
procedure needs to be developed. Fortunately enough, the whole set of stated below methods
provides for it.

» Make use of the updated “Backup accessory” version used in Windows 98. This program tools
make it easy to select the files to be saved and routinely backup them.
* Use the so called real backup, i.e. backup of the most significant files.

Disclosed below are the methods of work with Microsoft Backup utility, also described are
the real backup situations.

Main data on Backup

If backup utility is installed in your system, choose Start—>Programs—> Accessories—> System
Tools—>Backup to start it.

Backup utility will search for special backup devices within the installed hardware. In the
absence of such devices in your system the program will display a dialog window suggesting to
start installation wizard for such device. If your computer has this device, click on button Yes
and follow instructions from the wizard dialog windows to install it. Otherwise, click on button
No.

Each start of backup program results in displaying the dialog window as shown in Fig.1, with
the options stated below.
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Fig.1. Start window of backup utility

Create a new backup job. Selection of this switch and click on OK starts wizard that provides
for step-by-step execution of backup job. This job is described in more detail below in the part
devoted to definition of a new job. If you prefer to create a new job by yourself, click on Cancel.
This stage of manual definition of the job is given in more detail further on in this chapter.

Open an existing backup job. If some job has been already defined, select this switch and then
click on OK. Then in the displayed dialog window “Open Backup Job” select the required job
and click on Open.

Restore backed up files. When backup has been previously done, select this switch and click on
OK to restore these files. This stage of operation is also described in more detail below in one of
the parts of this chapter.

Real necessity of backup

Prior to starting backup, one needs to decide what particular files require it. True, it would be
logical first of all to try and backup all files, but this is possible only in the availability of a
sufficiently big size of the device that would store backup: hard disk, streamer, or network disk.

It is more difficult to choose files for backup when the backup storage device is of limited
size, or when backup is done on floppy disks. Although this utility can compress files almost
twice prior to backup, the size of these files can still remain too big — up to hundreds of
megabytes for big systems. Even a hard disk of low capacity can contain enough data fill several
dozens of floppy disks. No doubt, it is easy to go nuts just from routine extraction and insertion
of plenty of floppy disks. In such cases it would be wise to follow common reason considerations
as given below.

* The main difficulty in full backup is connected with copying program files. Let’s assume these
files exist on some other hard disks. Do we need in such case to backup them? No, because we
can always install them (and even Windows 98 itself) anew should it be required.

* [f program files also need backup, we should backup distribution disks. It can be done just once,
and for most important programs.

* All backup efforts should be focused on protection of the data and documents being backed-up
because, unlike the programs, they are unique. To simplify the process, it is recommended to
create individual folders for your documents (or to use for the purpose the folder My Documents
which is available in 8 Windows 98). Thus, addition of such documents to the job with the
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purpose of backup consists just in selection of a folder to be copied.

* Backup can be created through selection of one of the following backup types.

Full. Backup all files of the job.

Differential. Backup only those files which have changed since their last full backup.
Incremental. Backup only those files which have changed since their last full or differential
backup.

General backup strategy consists of the following measures.

1. Monthly full backup of all documents.

2. Weekly differential backup of all changed documents.

3. Daily incremental backup of all changed documents.

Backup job definition

In terms of backup a job is a file defining the backup method as based on the parameters
stated below.
* List of files for backup.
* List of backup parameters, for example, backup type.
* Storage for backup files, for example, disk or folder.

To define a backup job, it is possible to use wizard (this method is described in the following
part), or to create the job manually right in the Microsoft Backup utility window (this method is
described below in this chapter).

Use of Wizard to define a new job

Backup utility contains several wizards which can help you to go through all the backup
stages. The role played by wizards consists in rendering help with defining a new job. Wizard
can be started in one of the following ways.

* In Microsoft Backup start dialog window, click on “Create a new backup job”, then click on
OK.
* In Microsoft Backup dialog window, choose Tools—>Backup Wizard.

In any case, upon execution of these actions displayed will be the first dialog window of the
wizard with the two options as given below.

Back up My Computer. To fully backup all the local hard disks, choose this switch, then click
on Next.

Back up selected files, folders, and drives. To backup only selected files, folders and drives,
choose this switch, then click on Next.

In case of selective backup the next dialog window of the wizard will suggest you to choose
files for backup. It resembles Explorer window (Windows Explorer) with one significant
difference: all disks, folders and files in this window are provided with checkboxes. To select
items for backup, you have to check the corresponding checkboxes next to them, as shown on
Fig.2. To continue the procedure click on Next.
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Fig. 2. This dialog window is used to select disks, folders and files for backup

The next dialog window of the wizard will suggest you to backup all selected files, or only
those that have changed since their previous backup, with the help of the switches as given
below.

All selected files. When choosing this switch, backup will be created for all selected files.

New and changed files. When choosing this switch, backup will be created for all new or
changed files.

Choose what you need and click on Next to continue. The next dialog window will suggest to
define the backup storage place. Depending on the hardware configuration, the list will show the
following types of backup media.

File. This type of medium should be selected to save backup as QIC format file. The wizard will
help the user to enter the name and location of this file in the additional text box.

Backup Device. Choose this type of medium (which name depends on the type of installed
backup storage device) to use a special backup device.

Choose what you need and click on Next to continue. The next dialog window will allow to set a
number of requirements to the backup process.

Compare original and backup files to verify data was successfully backed up

With the checkbox for this option checked, the copy in the process of backup will be compared
with the original for possible mistakes. Please note that checking this option box will double the
backup time.

Compress the backup data to save space. With this option box checked, the backup data will
be stored compressed. And the size thereof will be some two times less than the original size.

To move to the next dialog window shown in Fig.3, click on Next. In the text box of this
window enter the name of the new backup job.
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Fig.3. In the text box of this dialog window enter the name of the new backup job

Now, click Start, and you can immediately start the backup process. The wizard can suggest
you to enter some unique name for the backup medium. In this case enter this name and click
OK.

While backup is in progress, the display will show the Backup Progress dialog window as
shown in Fig.4.

Upon completion of the backup progress, another dialog window will be displayed giving the
corresponding message. Having read this message, click OK, then click another OK in the
Backup Progress window. (In the Backup Progress window it is also possible, by clicking
Report, to bring up the dialog window with final report on backup completion.)
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Fig. 4. This dialog window will show information on backup progress

Independent backup job defining

Wizard is very convenient for the users who lack enough experience of work with backup
parameters. More advanced users can independently define backup jobs without wizard, rather
setting all parameters manually. This requires the use of the Microsoft Backup dialog window
shown in Fig.5.

Given below are the main steps to define backup job manually.

. To set parameters for the existing job, choose the job in the drop-down “Backup Job” list.
. Choose the job type with the switch “All selected files” or “New and changed files”.
. Use two other lists with scroll bars to choose the backup disks, files and folders with the help of

checkboxes.

. Use the drop-down “Where to back up” list to choose the backup medium type: file or a special

backup device.

. To set other backup job parameters, click Options. (These backup parameters are described in

detail in the next part.)
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Fig.5. To independently define backup job parameters without wizard, use Microsoft Backup dialog
window

6. To save a particular job, choose from the menu Job—>Save. When creating a totally new
job, enter its name in the “Save Backup Job As” dialog window, then click Save.

7. To start backup process, click Start. To view the completed job report, choose from the
menu Tools=>Report, then View or Print.
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General information on backup files: To view the data on the number of selected files and
their total size in bytes, choose from the menu View-> Selection Information.

Setting additional backup parameters

Backup can be done with various parameters which can be saved together with the job
definition. To view the available parameters, click Options in Backup, or choose from the menu
Job—>Options. Displayed upon completion will be the “Backup Job Options” dialog window
shown in Fig.6. The following parts describe the contents of all insertions in this dialog window.
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Fig.6. Upon selection from the menu Job > Options the display will show this dialog window
General parameters

In insertion General, you can check the box for the option “Compare original and backup
files to verify data was successfully backed up” to enable or disable verification of the backup
against the original.

The group of management elements “When backing up to media” contains the following
switches.
Never compress the data. Choose this switch to disable the data compression option.
Compress data to save time. With this parameter, selected the data will be somewhat
compressed to accelerate the backup process.
Maximize compression to save space. This option is recommended for use when backup device
has not enough space to store the copy in uncompressed way. This option gives higher level of
compression, but the backup process will take more time.

The group of options “If the media already contains backups” contains three other options.
Append this backup to my media. When using this option, the created backup will be added to
the existing backup on the backup devise in use.
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Overwrite the media with this backup. Choose this switch to remove the old backup and
replace it with a new one.

Let me choose this option during the backup. With this option selected, the user will be
suggested to complete the existing backup, or to replace it with a new backup.

Password

If storing backup on a network disk or in some other public place, it requires to protect backup
from any unauthorized access through checking the box for the option “Protect this backup with
a password” in Password. Having checked this box you have to enter the password in the text
boxes “Password” and “Confirm password”.

Type of backup

To set the type of backup, open insertion “Type” shown in Fig.7. Then choose the switch “All
selected files” or “New and changed files only”. When using the latter of the two options, choose
also one of the switches “Differential backup type” or “Incremental backup type”.
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Fig.7. To set the type of backup, choose insertion “Type”

Exclusion of files

Besides selection of backup disks, folders and files, insertion “Exclude” enables you also to
choose the type of files that will be excluded from the backup. Given below are the main steps to
exclude files from the backup process.

1. In insertion “Exclude”, click Add to display “Add Exclude” dialog window shown in Fig.8.

2. The list “Registered type” shows all types of files registered in Windows 98. (In more detail
these types of files are described in chapter 14, “Methods of work with files and folders™.) To
exclude one of these types of files, choose the switch “Registered type”, then check the required
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type of file in this list.
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Fig.8. To exclude files of some particular type, use this dialog window

3. It is also possible to exclude files of some particular type by means of choosing the switch
“Custom type” followed by entering in the text box of the 3-symbol extension for the excluded
type of files.

4. To return to insertion “Exclude”, click OK, and the set type of file will be placed in the list of
excluded files.

5. To exclude the files of other types, repeat the sequence of operations as described in clauses 1-4
for the required number of times.

Report contents

As it was shown above, upon completion of backup it is possible to view the final report of the
progress. To set the data included in this report, use checkboxes of the “Report” options as
shown in Fig.9.

Please note that this insertion is also provided with the checkbox for the option “Perform an
unattended backup”. With this option box checked, the backup process will proceed without
displaying additional dialog windows with messages or requests. It is convenient to use this
option for backup at night time, for example, with the help of “Task Scheduler”.
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Fig.9. Insertion “Report” allows to set the data to be included in the final report

System Registry backup

One of the most desired improvements of Windows 98 is the tool for backup of system
registry files as a part of some backup job. (Lack of this possibility in the backup utility was a
big drawback of Windows 95.) Enabling of system registry files is controlled by checking the
corresponding box of the option “Back up Windows Registry” in insertion “Advanced”. To

include system registry files in the backup when defining the job, it requires to make it sure that
the checkbox for this option is checked, Fig.10.
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Fig.10. Setting the option to backup system registry
Setting backup parameters

To set backup parameters to be used for all the jobs, it is possible to use the options of the
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dialog window “Preferences” shown in Fig.11. It can be displayed from the menu
Tools=>Preferences. Given below is the brief description of the options for this dialog window.
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Fig.11. This dialog window is used to set backup parameters to be used for all the jobs

Show startup dialog box when Microsoft Backup is started. By means of checking (or
unchecking) this option checkbox, it is possible to bring up (or hide) the startup dialog box of the
backup utility.

Back up or restore the registry when backing or restoring the Windows directory

With this option checked, the backup utility automatically includes system registry files in the
backup files if the main folder of Windows 98 is included in backup job.

Show the number and size of files before backing up, restoring and comparing data. With
this option checked, the backup utility will display the dialog box showing the number of files
for backup and their total size in bytes.

Restoration of backup

In case of emergency you will have to restore the data contained in the backup. Same as with
the backup process, data can be restored with the help of the wizard, or by independently setting
the restoration parameters.

Restoration of the backed up data with the help of wizard

Backup utility has another wizard which helps the user to restore step-by-step the perviously
created data backup. This wizard can be started in one of the following ways.
* In the startup dialog box of the Microsoft Backup utility choose “Restore backed up files”, then
click OK.
* In the Microsoft Backup dialog box choose Tools—>Restore Wizard.
In the first dialog box of the wizard, choose from the list “Restore from” the backup the data
from which need to be restored, then click Next.
The wizard will display in the next dialog box the list of backups found on this data medium.
Check the boxes of those backups the data from which need to be restored, then click OK.

After that the wizard will search for the disks, folders and files contained in the selected
backups. The search results will be displayed in the next dialog box as shown in Fig.12. Here
you need to check the boxes next to the items the data from which you want to restore, and click
Next.
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Fig. 12. This dialog box is used to select disks, folders and files to be restored

In the next dialog box of the wizard you must specify the location to restore the files with the
help of “Original Location” or “Alternate Location” from the drop-down list. When choosing the
latter of these two elements from the list, the user will be offered to enter in the text box the new
location of the restored files. Upon completion, click Next.

After that, in the next dialog box of the wizard, as shown in Fig.13, you will be offered to
define the way to restore files, if the location already has files with the same names. One of the
options from those given below can be used for this purpose.

Restore Wizard

How ta restare

Specify whether existing filez zhould be replaced during
restare.

Wwhen restoring files that already exist

i ;ch nat replace the file on my computer
rsrnmmendsd]

™ Replace the file on my computer only if the fils iz
older.

i~ Alwayps replace the file on my computer.

Click Start to beqin restoring files.

Cancel < Back HERt Start

Fig.13. In this dialog box of the wizard you have to specify the way to restore files if the location already
has files with the same names

Do not replace the file on my computer. With this option selected, no files in the place of
restoration (disk or folder) will be replaced with restored files having the same names.
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Replace the file on my computer only if the file is older. With this option selected, old files in
the place of restoration (disk or folder) will be replaced with the restored files having the same
names.

Always replace the file on my computer. With this option selected, any files in the place of
restoration (disk or folder) will be replaced with the restored files having the same names.

To start the restoration process, click Start. After that displayed will be the dialog box
suggesting to insert the medium with backup. If necessary, insert the required medium, then click
OK.

During the backup the monitor will display the window “Restore Progress”, while upon its
completion displayed will be the dialog box with the message on completion of this operation.
Click OK in this dialog box, then click OK in the window “Restore Progress”. (Besides, to view
the final report on completed backup process you can click Report.)

Independent restoration of backup with manually set parameters

To restore backup it is possible to set independently the parameters for this process, and start it
with the actions as described below.
1. In the Microsoft Backup dialog box choose “Restore” as shown in Fig.14.
2. Choose the required backup from the option list “Restore from”.
3. Check the boxes next to those disks, folders and files which need to be restored.
4. To set the location for the restored data use the list “Where to restore” and select either
“Original Location” or “Alternate Location”.
5. To set the restoration parameters click Options. (In more detail this operation is described in
the next part.)
6. To save the set parameters, choose from the menu Job—> Save.
7. To execute the restoration process click Start.
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Fig.14. To restore backup you have to use “Restore” in the Microsoft Backup dialog box
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Setting additional restoration parameters

To set additional restoration parameters, click Options in “Restore” or choose from the menu
Job—>Options. Upon completion of these actions displayed will be the dialog box “Restore
Options” as shown in Fig.15.
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Fig.15. This dialog box is displayed when choosing from the menu Job—>Options

The number of additional parameters for restoration job is less that the number of additional
parameters for backup, and all of them are set with the help of the management elements from
the insertions as listed below.

Insertion General. Choose one of the switches of the group “When restoring files that already
exist” to set the way to place the restored files and the existing files having the same names.
These options are identical to those which are used while working with the wizard.

Insertion Report. With the help of parameters from this insertion we can define the contents of
the final report on completion of the restoration process.

Insertion Advanced. By checking the option box “Restore Windows registry”, we can specify
the necessity to restore the system registry files.
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